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The GBM view of a burst.

‣ Each detector views part of sky i.e. has a different “ROI”.  Information is stored in 
separate files for separate detectors.

‣ Find out from quicklook plots which detectors had a good view of the burst.

3

4
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Retrieving GBM Data
‣ Directly by ftp at:  http://heasarc.gsfc.nasa.gov/FTP/fermi/data/gbm/triggers   if you 

know the full name of the burst e.g. 080916009.  Look for the files you want 
under the “current” directory for the burst.

‣ Using the FSSC interface:  http://fermi.gsfc.nasa.gov/ssc/data/access/  under “GBM 
Burst Catalog”.   You will see a page with explanations about GBM data.  Click the 
“Browse this Table” at the top left-hand corner.   Search for your burst by entering 
“GRB080916*” under the “name” field in the table.    Select your burst from the 
returned triggers using your knowledge of the trigger time.  “Preview and 
Retrieve” will allow you to generate the directory listing the available data files for 
this burst, or you can just retrieve the whole available data package in a tar file.

‣ CSPEC files are “glg_cspec_nx_bn080916009_v0y.pha”   where x is the NaI 
detector number 0-9, a, b    or “glg_cspec_bx_bn080916009_v0y.pha” with x =0 
or 1.    Choose b0 if you have low-numbered NaI, b1 for NaI with x>5.  If you have 
a mixture, select both BGOs and choose better one after looking at data.

‣ TTE files are “glg_tte_nx_bn080916009_v0y.fit”...

‣ In either case, you will need a detector response file for each detector you are 
analyzing   “glg_cspec_nx_bn080916009_v0y.rsp”.   CSPEC response files apply to 
both CSPEC and TTE data files:  the number of energy channels is 128 for both.

‣ Quicklook lightcurves are called glg_lc_all_bn080916009.gif

‣ The version number v0y is unimportant and can be different for each file type. 

Wednesday, April 7, 2010 DOY 97

http://heasarc.gsfc.nasa.gov/FTP/fermi/data/gbm/triggers
http://heasarc.gsfc.nasa.gov/FTP/fermi/data/gbm/triggers
http://fermi.gsfc.nasa.gov/ssc/data/access/
http://fermi.gsfc.nasa.gov/ssc/data/access/


rmfit tutorial                                                                                                                     The rmfit team,  April 2010

Selecting Data Type

‣ 3 burst data types: 

‣ TTE (Time-Tagged events) : Event data.  Individual photons (or CRs) with time 
tag and energy.    128 Energy channels.  Each “row” of Event extension in Fits 
file is a time and an energy channel.

‣ CSPEC:   Binned in 1.024 s bins.  128 Energy channels.  Each “row” of Spectrum 
extension in Fits file is a 128 energy channel spectrum applying to 1 s of data.

‣ (CTIME:  Binned in 0.064 s bins.  8 Energy channels: not suitable for 
spectroscopy).

‣ Look at quicklook lightcurve to estimate duration of triggered event.

‣ Choose TTE for short (< few seconds) or highly structured events.  CSPEC for 
longer events.    TTE is gathered only for ~ -25 s before to 300 s after trigger 
time.    TTE is also slower to process in the spectral analysis program.

‣ [PHA files from other experiments e.g. Swift BAT can also be analysed using rmfit, 
providing they have a single associated response file, and conform to standard fits 
format.  Swift BAT files are single PHA files i.e. one spectrum per file.  CSPEC/
CTIME files are PHA 2 files i.e. multiple spectra per file, each spectrum belonging 
to a time bin.]
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Data set for this example

‣ I would probably choose 1 more NaI detector in a “real” analysis in this case.   No 
simple prescription for number of detectors to use.   Choose the brightest 2 NaI 
detectors...  the usefulness of further additions depends on how bright the burst 
was and its geometry.   Using more than 4 NaI detectors rarely adds any new 
information.

glg_cspec_b0_bn080916009_v01.pha 
glg_cspec_b0_bn080916009_v06.rsp 
glg_cspec_n3_bn080916009_v01.pha 
glg_cspec_n3_bn080916009_v06.rsp 
glg_cspec_n4_bn080916009_v01.pha 
glg_cspec_n4_bn080916009_v06.rsp 
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Running rmfit
‣ At the command line, type “rmfit”.   The first time you use rmfit in a particular 

directory you will be asked if it is ok to set up a parameter file there.   Click “yes” 
unless you have mistakenly invoked rmfit in a directory to which you do not have 
write access.   If it is not the first time you run rmfit in this directory, the 
parameter file from your previous session will be read.

‣ You will be prompted via a graphics widget to select a data file.    You will need to 
tell rmfit in the “Directory” field where to look for the data file.  The data files for 
this analysis are in /Users/valerie/Documents/Bangalore/gbm_data_080916c.

‣ The default search is for files ending in “.pha” i.e. spectrum files, but you can use 
the drawdown menu to look, for example, for TTE files (.fit).

‣ Select 1 data file  e.g. 
glg_cspec_n3_bn080916009_v01.pha. 

‣  Click “Ok”.
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The lightcurve window

‣ Each point in the lightcurve shows the counts registered in that time bin over the 
energy range shown top right, converted to a rate (cts/sec).    The resolution 
changes from 4.096 s to 1.024 s at trigger time for CSPEC data.    TTE data (which 
are unbinned in time) are binned here to a default 128 ms, but you can refine this for 
individual bins.  CSPEC data cannot be refined below their native resolution, but can 
be combined to coarser resolution.

‣ A window will pop up showing the lightcurve for what this detector saw from -4000 s 
before the trigger to 4000 s afterwards.    The gaps are Fermi passages through SAA.  
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The Spectrum Window
‣ Press “Toggle” on the lightcurve window to reveal the spectrum window.

‣ Each spectral bin shows the total number of counts in the energy bin (0-127) 
corresponding to the energy shown on the x-axis, converted to a rate per s per 
keV  i.e. this is the average spectrum integrated over the 8000 s of data in your 
file.
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Making data selections

‣ To Select ranges, after clicking the appropriate selection button:

‣ On the plot, click the ranges that interest you OR

‣ Click below the plot to bring up a pop-up window that takes numerical input 
for range selections.

‣ In either case, when you are happy with selection, click to the left of the plot 
(you will see “exit” when you move the mouse over this area) to save.

‣ To cancel/reset a selection, click to the right of the plot before saving. 

‣ To Adjust ranges:

‣ Use clickable buttons e.g. “Adjust source” and its sub-options.

‣ Use keystrokes defined in key-bindings menu which is seen by clicking “Misc” 
and “Show keyboard bindings”.
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Selecting a spectral range

‣ GBM NaI spectra are useful between 8 keV and ~900 keV (making sure the 
overflow bins are not selected).  For BGO, the useful range is 200 keV --> ~40 
MeV (also excluding the overflow bins).

‣ Click “Select Source” , “Source Interactive” and click in the plot area the lower 
and upper bounds you wish to select.    Click on the left margin to save.

‣ You can adjust your selection using “Adjust source” menu or keystrokes from 
keyboard binding menu.
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Zooming in on your lightcurve

‣ Press toggle in the spectrum window to reveal the lightcurve window.  Your 
lightcurve will now be the total count rate as a function of time in your selected 
energy range (shown top right).

‣ Zoom in on the time of interest (around the trigger time) using the widget buttons 
“Zoom” and “X Zoom”.  Clicking in the plot area on the time before and after the 
trigger you want to look at.   You can zoom in in several stages, before clicking in 
the left margin (“Exit”) when you are happy.    Clicking “Zoom” and “Zoom out: full 
range” will get you back to the original stretch of time.
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Fitting and subtracting background
‣ Zoom in/out in the lightcurve interval to show a long enough period to choose 

time intervals that will provide you with a good sampling of the background.   
Deciding when the burst is over may not be easy.  Deciding how much background 
to choose comes down to experience.  You do not want the uncertainties in your 
fit to be dominated by uncertainties in your background, and you don’t want to 
take a background interval so long that it is challenging to fit what is going on at 
the time of the burst.

‣ Click “Fit Background” and click left-and-right boundaries for at least one, but as 
many intervals as you would like to use to fit the background.   Click the left 
margin when you are finished.   Typically, we use one interval before and one after 
the burst, but there may be exceptions depending on the shape of the background 
and the morphology of the burst.
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Background fitting (2).
‣ When you click “Exit” you will be prompted for the order of polynomial you want 

to use.    This depends on the background:   sometimes a linear fit will be good, 
others require a cubic.     Once you choose the order of the fit, a chi2 plot 
showing the goodness of fit as a function of energy will be returned.  Click 
“dismiss” to return to the lightcurve screen.   The background fit you selected will 
be shown as a blue dashed line.   If you are not happy with this, click “fit 
background” again and repeat.  You do not have to choose new intervals (unless 
you want to) to experiment with the order of the fit.   Clicking the left margin 
after hitting “Fit background” will prompt you for the order of the fit while 
preserving your current interval selections.
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Selecting your source interval

‣ Zoom in on the region of the burst using the “Zoom”  “X Zoom” options.  You 
will now get a better idea if the background you chose is appropriate.    If it is, you 
are ready to select the interval in time you want to analyze i.e. the burst emission.

‣ Click “Select Source” then “Source interactive” and click the plot to select your 
source interval.    There is a limit to how long a single response function is 
appropriate  [This limit will soon go away owing to the implementation of rsp2 
(multiple response) files that generate and allow rmfit to use a new response for 
every 5 deg of spacecraft slew].   Here, I choose about 70 s of the brightest part.
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Binning your source selection

‣ In preparation for doing time-resolved spectroscopy, time bins for the spectra 
need to be defined.  In practice, this is done carefully, by looking at the structures 
(peaks) in all the instruments involved in the fit, and selecting bins accordingly.  
Here, I bin for signal-to-noise in this particular detector.  The same bins MUST be 
used for all detectors involved in the fit to make this scientifically useful.    If you 
are interested only in a time-integrated fit i.e. you want to measure only one 
spectrum, that of the total number of counts in your entire source interval, then 
you can skip this step.

‣ Click “Rebin” and then “Signal to noise”  (you can use any binning scheme, this is 
just an example) and a reasonable value, say, 20 sigma for the SNR.   Your 
lightcurve will now have unevenly spaced bins, each with AT LEAST 20 sigma SNR.
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Looking at your spectrum
‣ Click toggle on the lightcurve window to reveal the spectrum integrated over the 

source interval you selected (all time bins summed).  Remember these spectra are 
in count space and the shape is more a display of the effective area of the detector 
as a function of energy than the true source/background spectrum.

‣ The blue line is the estimated background during your chosen source interval.  
Anything above this is emission from the burst during this time.  This gives an idea 
in count space of how high in energy this burst can be seen by GBM.  Here, it is 
clearly seen over the entire energy range.   You can bin the spectrum in energy as 
you binned the lightcurve in time.  This does not change the binning in the fits, it is 
just for display.
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Saving your information

‣ Using “File”  “Lookup” “Save lookup” from either the lightcurve or the spectrum 
window, you can save your selections (zoom level, background fit, source selection,  
binning) in an ascii lookup file.  This file can have any name.  If its name is the same 
as the data file, apart from a “.lu” extension in place of a “.pha” or “.fit” extension, 
(the default) then it is read in automatically when you next load your data file.    
You can have multiple lookup files for a data file, any of which can be read in 
manually.  Press “ok” to save under the default name.

‣ We will use the lookup file from this file (detector n3) to set up the other 
detectors (n4 and b0), but you must be careful to adjust the energy and 
background selections to be appropriate for the other detectors after reading in 
this lookup file.
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Reading in more data files.

‣ There is no limit (or the limit is higher than the number of files you would 
reasonably be expected to fit for a particular event) to the number of data files 
you can fit simultaneously.

‣ Select a new file by choosing the “Load” command on the little window with the 
rmfit version as its title.  You will be offered a menu of files from your current data 
directory, but you can select files from anywhere using directory navigation.  

‣ We have chosen here to read in the CSPEC file for NaI number 4.  i.e. 
glg_cspec_n4_bn080916009_v01.pha.  There are now 2 files in the rmfit window 
and a new lightcurve window will pop up with the lightcurve for NaI 4.
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Shortcut for extra files

‣ Read in the lookup for the first detector to initialize the selections for the new 
detector.    This is convenient, and in this analysis, this step is necessary in order to 
get the same time bins for all the detectors involved because we binned for signal-
to-noise in a particular detector.  Select (in the n4 window) “File”  “Lookup”  
“Read Lookup” and select the lookup file for NaI 3.

‣ If the energy selection (look at top right of lightcurve) is ok (> 8 keV -- ~900 keV 
for NaI, > 200 keV -- ~40 MeV for BGO) and the background fit (blue line) looks 
ok, then save this lookup using “File” “Lookup”  “Save Lookup” where the default 
will be appropriate for this new file.   You can also change the energy selection and 
the background fit as was done for the first detector, but do not change the 
source time interval or its binning in time.
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Shortcut for extra files (2)

‣ Next we load the BGO file glg_cspec_b0_bn08096009_v01.pha and read in the 
lookup file from one of the NaI detectors.   

‣ In this case, the energy range is incorrect and energy selection will need to be 
done as was done for this higher-energy detector.   (You should now be able to do 
this....   “Toggle” to get spectrum window,  “zoom”  “zoom out full range” to reveal 
whole energy range “select source” “source interactive” and click on the lower 
and upper energy ranges in the plot (200 keV -- 40 MeV),  “exit” to save, then 
“toggle” to get the lightcurve back.   You may need to use “zoom”   “y 
zoom” (click on the y axis range of interest) to get a better look at the lightcurve.  
If the background looks ok, save your lookup file  using “File”  “Lookup”   “Save 
lookup”).
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Fitting GBM Spectra

‣ The technique uses forward folding to walk through parameter space,  using the 
detector response to evaluate the expected rates for the model with the set of 
parameters at each stop on the way.   The test statistic compares these model 
rates with the observed rates,  The fitting process converges (we hope!) on the 
best set of parameters for that particular model and returns the parameters and 
the value of the test statistic.

‣ rmfit supplies several test statistics:    We always use C-Stat which is 
-2*log(likelihood) though for historical reasons, the default statistic is χ2 .

‣ From one of the 3 detector windows, select “Spectral Fitting” then “Fit 
Selections”.  This produces a fit of the entire source  interval (which you selected) 
with some model you will choose.

‣ You will be prompted for the detector response file, one per detector.   This is 
the .rsp file e.g. glg_cspec_n3_bn080916009_v06.rsp.   Select and click “ok”.   You 
will be asked which detectors to include in the fit.   Press “Accept” to select all of 
them.   This will cause the fit to occur jointly over all the detectors i.e. your fitting 
statistic will be optimized using information from all 3 detectors.
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The Model window

‣ You have many models to choose from.   If you click 
“Restore” you will get even more models which are 
not offered by default.    Try, in turn, 1, 7, and 5, noting 
which produces the best fit.  Clicking a model selects 
it.  Holding <ctrl> down while clicking another model 
adds it to the 1st one.

‣ Starting parameters for 1,5,7 are usually good enough, 
but for lines and cutoffs and other components you 
add, you will need to click “Set parameters” to give 
the fit a starting point.

‣ Click “C-stat” to use -2log(likelihood) as your fitting 
statistic.

‣ Click “Accept” to perform the fit.

2 new windows will pop up:  A spectral fit window, and one with 
details of the fit and its parameters and derived quantities
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A bad fit

‣ Using the PL fit (option 1 from the model selection window):

‣ C-stat (likelihood) cannot be used to estimate goodness of fit, only compared to  
C-stat for other (nested) models.

‣ Residuals (bottom plot) are terrible over the entire energy range i.e. Bad Model.

Red and yellow [green] points are the NaI 
[BGO] detector rates.   Blue curves are the 

model rates i.e. the expected detector 
rates, given our detector response, if this 

model were the “true” one.
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A better fit
‣ From the “Fit Display” window, select  “Redo Last Fit”.  This time, select option “7” 

which is called Comptonized Epeak  and is a power law with an exponential cut-off 
above an energy Epeak

‣ Clearly a better model than the power law.

‣ In a proper analysis, would have rebinned spectral bins to show fit vs model.

At low energies data rates lie quite close 
to model curve, but fall-off appears too 

steep in model compared to data, though 
with many upper limits it is hard to tell.
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Rebinning spectral data
‣ In BGO (b0) window, toggle to reveal spectrum.   

‣ Click “Rebin” then “Combine bins” and “Combine by” and enter “4”.   

‣ Click the range you want to rebin.  I chose from 1 MeV to 40 MeV.

‣ Redo the fit from this (or the other detector) windows, not from the “Fit display” 
window, as you have changed one of the display parameters. Click “Spectral 
Fitting” then “Fit Selections”, accept all detectors and choose “7” as the model.

The data points and residuals show that the 
exponential cut-off really is too steep.

Notice that in the fit parameters window, 
the parameter and statistic values do not 

change when the energy data are rebinned.  
Fitting is always done at the highest 

resolution.
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A Good Fit
‣ From the Fit Display window, click “Redo Last Fit” and choose “5”,  the Band GRB 

function.  This is the same as “7”, but with a power-law above the cut-off energy 
instead of an exponential fall-off.

‣ ΔC-Stat = -28 for 1 extra parameter.  These are nested models so can be 
compared as for Χ2.

‣ Residuals look better, with no systematic excess above Epeak.

Notice Covariance 
i.e. parameters are 

correlated.
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Correcting any normalization 
issues.

‣ Allow the normalization of detectors to vary using the “Effective Area 
Correction” in addition to the chosen model.    Select “Redo Last Fit” and hold 
<ctrl> key to select from the model window, in addition to option “5”, option 
“40”.   Click  “Set Parameters” to choose which detector areas to vary.    Click 
“Accept”.

‣ A window will pop up with all your starting parameters.   At the bottom, click 
“Vary” for each of the 2 normalization parameters.   Click “accept”.

With only -3 as an improvement in 
likelihood, and 2 extra parameters, this does 
not seem to be a necessary addition to the 
model, particularly with such small effective 
area corrections.  These corrections are for 

NaI 4 relative to NaI 3 and BGO 0 relative to 
NaI 3.  Possibly there is a couple % 

normalization factor between the BGO and 
the NaI detector, but it is not required 

statistically so we will not apply it.
Redo last fit with model 5 only.
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Errors in parameters.

‣ The fitting engine returns symmetrical errors which may not be appropriate.  
When the final parameters are obtained, calculate asymmetric errors by clicking 
“Spectral Fitting” then “Error interval” in the Fit Display window.  Select all 
parameters of interest and click “Accept”.   The fit window will show these errors.
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Correlation of parameters

‣ In Fit Display window, click “Spectral Fitting” and “Chi2 2D plot”.  A window will 
pop up allowing you to select pairs of parameters to map out the allowed space 
for these pairs of parameters. 
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A quick look at detector responses

‣ Response of detector is a combination of direct photopeak response i.e. the 
photon loses all its energy in the detector;  a scattered response where only 
partial deposition occurs; and an indirect response from photons scattered off the 
Earth’s atmosphere.  

‣ Click “Options” and “Display Default DRM” to look at detector response 
function.
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Time-resolved spectra

‣ To look at the spectral evolution of this burst, in the Fit Display window, click 
“Spectral fitting” and then “Batch Fit Selections”.   The fitting engine will start with 
the best-fit time-integrated parameters and cycle through each of the bins you 
decided on when you selected time intervals for NaI 3.   For each bin, the best-fit 
parameters using your chosen model will be found.

‣ In the Fit Display window, you can now see a new set of tabs under “Batch Plot 
options” .  Click “Fit Parameters” to follow the evolution over the time bins of 
each parameter.

Zoom in on regions of interest in time 
and parameter value using the “Zoom” 

option.

If the fit fails to constrain this 
parameter in a time bin, it will be 
shown as a horizontal bar with no 

vertical error bar. Parameters which 
cannot be fit are frozen by default.

Wednesday, April 7, 2010 DOY 97



rmfit tutorial                                                                                                                     The rmfit team,  April 2010

Burst Flux and Fluences
‣ After doing a batch fit, click “Fit Parameters” in the Fit Display window, then 

“Photon Flux” or “Energy Fluence”.  

‣  

‣ Energy range for these calculations is changed by clicking in Fit Display window 
the “Options” tab along the top of the window and then “Set Fluence Energies”.  
The fluence can also be calculated for the time-integrated spectrum from the 
values shown in the fit parameter window.  An energy flux is provided which can 
be multiplied by the duration of the interval to get the fluence.

‣ You can dump all these results to a log or to fits files using options from the “Fit 
Results” button.
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Global Spectral Evolution
‣ After batch fitting, in the Fit Display window, click “Stack Spectra” and “Stack 

nuFnu” buttons.

The blue dashed line is the time-
integrated nuFnu.  The yellow->red 
color scheme shows the 33 spectra 
from start to end of the burst.  No 
data points or errors are shown in 

these plots.  They just give a 
visualization of the global spectral 
evolution throughout the burst.
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Other Information

‣ There is “Help” available in rmfit itself, and many options and functions have not 
been explained here.

‣ It is possible to add your own spectral fit models but this requires using the 
“source” version of rmfit, editing the mfit fortran code to define as one of the 
user-input functions MFIT_USER_FUNC_A through D in the source code 
mfit_user_func_a.f90 etc. and remaking the mfit dlm.  MFIT_USER_FUNC_A and 
other user functions appear on the “restored” version of the spectral models 
offered when fitting spectra in rmfit.

‣ Help is available from the developers and suppliers on the GBM team:  Rob Preece 
rob.preece@nasa.gov,  Michael Briggs michael.briggs@nasa.gov, and Valerie 
Connaughton valerie@nasa.gov.
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